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Chapter – 4 (100 MCQ) 

Spreadsheet  

(LibreOffice Calc) 

There are 100 Multiple Choice Questions. The questions are from Chapter-4 

Spreadsheet MCQs of CCC. All questions of Introduction to Computer MCQs 

are in Hindi languages. All questions contain 4 options and the right answer. 

An Spreadsheet MCQs are given in this article according to the NIELIT CCC 

syllabus. 

 

Q.1. ननम्न में से लिबे्र ऑफफस कैल्क में नंबर का एिाइनमेंट कौन सा होता है? 

(A) Left      (B) Right    

(C) Center      (D) None                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                  

Q.2. LibreOffice Calc में प्रटं रीव्यू की shortcut key क्या? 

(A) Ctrl + Shift + O     (B) Ctrl + P   

(C) Shift + P      (D) Ctrl +Shift + P 

Q.3. ननम्नलिखित में से कौन सा ऑप्शन जूम लिबे्र ऑफफस कैल्क का है? 

(A) 10% to 600%     (B) 5% to 600%  

(C) 20% to 400%     (D) 20% to 600% 

Q.4. लिबे्र ऑफफस कैल्क में कुि फकतनी वकक शीट होती हैं? 

(A) 16384       (B) 32000 

 (C) 45000       (D) None of These 
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Q.5. LibreOffice Calc में पूरे सीट लसिेक्ट करने के लिए फकस कंुजी का 
रयोग करेंगे? 

(A) Ctrl + Shift + Space    (B) Ctrl + A   

(C) Shift + A      (D) A & B  

Q.6. सेि को एडडट मोड में करने के लिए फकस कंुजी का रयोग करत ेहैं? 

(A) Ctrl + F2      (B) F2  

(C) Shift + M      (D) Shift + F2 

Q.7. फामूकिा जो फक D4 की वैल्यू तथा C2 की वैल्यू से जोड़ने के बाद B2 की 
वैल्यू से गुणा करेगा? 

(A) (D4+C2)*B2      (B) D4+C2*B2  

(C) =(D4+C2)*B2     (D) =[(B2*(D4+C2)] 

Q.8. LibreOffice Calc में पेज बॉडकर कैसे सेट कर सकत ेहैं? 

(A) Format-> Page Border    (B) Insert-> Page-> Border  

(C) Insert-> Page Border    (D) Format-> Page-> Border 

Q.9. LibreOffice Calc में Cell फॉमेटटगं के लिए फकस शॉटककट कंुजी का 
रयोग करत ेहैं? 

(A) Ctrl + 1      (B) Ctrl + F2 

(C) Ctrl + M      (D) Ctrl + 2  

Q.10. LibreOffice Calc में कुि फकतने कॉिम होत ेहैं? 

(A) 1024       (B) 1048576 

(C) 16384       (D) None of these  
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Q.11. लिबे्र ऑफफस कैल्क में वह कौन सा फंक्शन है जो लसफक  Date Show 

करता है? 

(A) Now()       (B) Weekdays() 

(C) Today()      (D) None of the above  

Q.12. स्प्रेडशीट में सबसे नीचे वािी ROW तक जाने के लिए हम कौनसी 
शॉटककट कंुजी का रयोग करत ेहै? 

(A) Ctrl + Down Arrow    (B) Ctrl + Shift + Down Arrow 

(C) Both A & B      (D) None of the above  

Q.13. =ceiling(99,7) का पररणाम क्या होगा? 

(A) 103       (B) 98 

(C) 105       (D) 99 

 

Q.14. लिबे्रऑफफस कैल्क स्प्रेडशीट में ननम्नलिखित में से कौन सी डडफॉल्ट 
फॉन्ट स्प्टाइि है? 

(A) Bold Italic      (B) Italic 

(C) Bold       (D) Regular 

 

Q.15. ननम्न में से कौन सा फामूकिा सही है? 

(A) Max (A1,A12)     (B) Max ( A1: A12) 

(C) =Max(A1,A12)     (D) =MAX(A1:A12) 

 

Q.16. लिबे्र ऑफफस कैल्क में फकसके द्वारा Row का रनतननधधत्व कर सकत े
हैं? 

(A) 1,2,3,4       (B) A, B, C, D 

(C) A1, B1, C1      (D) 1A, 1B, 1C 
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Q.17. िोअर केस में लििे हुए टेक्स्प्ट को आप अप्पर केस में करने के लिए 
कौन सी कमांड का रयोग करत ेहैं? 

(A) Cycle case      (B) =Upper(text) 

(C) =Proper(text)     (D) None 

 

Q.18. यटद फामूकिा को कॉपी करने पर सेि का एड्रसे बदि जाता है तब उसको 
कहत ेहै? 

(A) Absolute address     (B) Mixed address 

(C) Relative address     (D) Dynamic address 

Q.19. LibreOffice calc में फंक्शन insert करने के लिए फकस कंुजी का 
रयोग करत ेहैं? 

(A) Ctrl + F5      (B) Ctrl + F1  

(C) Ctrl + F3      (D) Ctrl + F2  

 

Q.20. LibreOffice Calc में डडफॉल्ट फाइि एक्सटेंशन क्या है? 

(A) .odt       (B) .odp  

(C) .ods       (D) .xlsx 

 

Q.21. LibreOffice Calc Spreadsheet में ननम्नलिखित में से कौन सा 
डडफॉल्ट फॉण्ट आकार है? 

(A) 12       (B) 10  

(C) 14       (D) 15 

 

Q.22. LibreOffice Calc के अंतगकत फकतने रकार के चाटक उपिब्ध रहत ेहैं? 

(A) 19       (B) 10  

(C) 14       (D) 12 
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Q.23. ऑटो फफल्टर प्वकल्प LibreOffice Calc के फकस मेनू में उपिब्ध है? 

(A) File       (B) Sheet  

(C) Insert       (D) Data 

 

Q.24. वतकमान सेि को संपाटदत करने हेतु हम कौनसी शॉटककट कंुजी का रयोग 
करत ेहै? 

(A) Ctrl + F2      (B) Ctrl + F5  

(C) F2       (D) F1 

 

Q.25. लिबे्र ऑफफस कैल्क रोग्राम में A1, A2, A3, A4 सेि में कुछ संख्याएं दी 
गयी हैं इनको Transpose करने पर सेि एड्रसे क्या होगा? 

(A) A1, B1, C1, D1     (B) B1, C1, D1, E1  

(C) B1, B2, B3, B4     (D) A1:B4 

 

Q.26. LibreOffice Calc फाइि by default फकस नाम से सेव होता है? 

(A) Untitled1      (B) Spreadsheet1  

(C) Calc1       (D) None 

 

Q.27. Product (7, 8) का क्या मान होगा? 

(A) 15       (B) 1  

(C) 56       (D) 66 

 

Q.28. LibreOffice Calc और राइटर में Ctrl + D का काम समान होता है? 

(A) True       (B) False  



6 
 

Q.29. अगिी सीट में जाने के लिए फकस कंुजी का रयोग करत ेहैं? 

(A) Tab       (B) Ctrl + Tab  

(C) Ctrl + Shift + Tab     (D) Shift + Tab 

 

Q.30. LibreOffice Calc में फकसी value को हाईिाइट करने के लिए फकस 
शॉटककट कंुजी का रयोग करत ेहैं? 

(A) Ctrl + F6      (B) Ctrl + F7  

(C) Ctrl + F8      (D) Ctrl + F1  

 

Q.31. LibreOffice Calc में फकसी सेि का एड्रसे कहां टदिाई देता है? 

(A) Formula Bar     (B) Address Book  

(C) Name box      (D) None  

 

Q.32. लिबे्रऑफफस कैल्क रोग्राम में लसिेक्ट फकये हुए सेि को कैसे पररभाप्ित 
फकया जा सकता है? 

(A) A Deep Wide Border    (B) A Dotted Border  

(C) A Blinking Border    (D) By Italic text  

 

Q.33. लिबे्र ऑफफस कैल्क में Wizard के लिए हम फकस मैन्यू का रयोग करत े
है? 

(A) File       (B) Insert  

(C) Edit       (D) None 

 

Q.34. ननम्न में से कौन-सा फाइनेंलसयि फंक्शन नहीं है? 

(A) FV()       (B) PMT()  

(C) NPV()       (D) SUM() 
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Q.35. कैल्क में A1+A2 को जोड़ने के लिए कौन सी शॉटककट कंुजी हैं? 

(A) =A1+A2      (B) =Max(a1+a2) 

(C) =Add(a1+a2)     (D) None 

 

Q.36. ननम्नलिखित में से सेि में ##### क्या रदलशकत करता है? 

(A) सेल की चौड़ाई स़ामग्री के प्रदर्शन से अपऱ्ाशप्त है       

(B) फ़ाममशल़ा गलत है। 
(C) ड़ाट़ा म़ान्र् नह ीं है      

(D) कोई नह ीं 
 

Q.37. ननम्नलिखित में से कौन LibreOffice Calc Spreadsheet में फॉन्ट 
आकार के ड्रॉप डाउन मेनू में उपिब्ध फॉन्ट साइज में से एक है? 

(A) 31       (B) 29 

(C) 30       (D) 28 

 

Q.38. Calc में टदनांक डािने के लिये शॉटककट कंुजी क्या होती है? 

(A) Shift + ;      (B) Ctrl + : 

(C) Ctrl + ;       (D) None 

 

Q.39. वतकमान में अगर आप Libreoffice Calc स्प्रेडशीट में H7 सेि पर हैं तो 
कीबोडक की होम कंुजी को दबाने के बाद आप ननम्नलिखित में से फकस में होंगे? 

(A) A1       (B) H7 

(C) A7       (D) B1 

Q.40. Ctrl + F2 शॉटककट कंुजी का रयोग फकसके लिए करत ेहै? 

(A) Function Wizard     (B) Print Preview 

(C) Format Cells     (D) None of these 
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Q.41. लिबे्र ऑफफस कैल्क में प्पछिी सीट पर जाने हेतु हम कौन सी शॉटककट 
कंुजी का रयोग करत ेहै? 

(A) Ctrl + Tab      (B) Both 

(C) Ctrl + Shift + Tab     (D) None 

 

Q.42. आप एडडट मेनू टै्रक चेंज सब मेनू के ररकाडक प्वकल्प का उपयोग करके 
लिबे्रऑफफस स्प्रेडशीट में फकए गए पररवतकनों को ररकाडक कर सकत ेहैं? 

(A) True       (B) False 

Q.43. फकस ऑप्शन में हाइड कॉिम ऑप्शन उपिब्ध है? 

(A) Sheet       (B) Format 

(C) View       (D) Style 

 

Q.44. लिबे्र ऑफफस कैल्क में ननम्न में से फकसके द्वारा कॉिम का रनतननधधत्व 
कर सकत ेहैं? 

(A) 1,2,3,4       (B) A,B,C,D 

(C) A1,B1,C1      (D) 1A,1B,1C 

 

Q.45. ननम्नलिखित में से सही फॉमूकिे क्या है? 

(A) SUM(D1:D2)     (B) =Sum(D1?D2) 

(C) SUM(D1,D2)     (D) =Sum(D1:D2) 

 

Q.46. लिबे्र ऑफफस कैल्क के अंतगकत सेि को फॉमेट करने वािा डायिॉग 
बॉक्स को िोिने के लिए हम कौन सी शॉटककट कंुजी का रयोग करत ेहै? 

(A) Alt + 1       (B) Ctrl + 1 

(C) Alt + Shift + 1     (D) None 

 



9 
 

Q.47. लिबे्र ऑफफस कैल्क में सेि के अंदर एक नई िाइन अथवा पैराग्राफ को 
बनाने के लिए Ctrl कंुजी के साथ कौन सी कंुजी का रयोग फकया जाता है? 

(A) Alt        (B) Ctrl 

(C) Shift       (D) Enter 

 

Q.48. लिबे्र ऑफफस कैल्क में जजस स्प्थान पर कॉिम तथा रो एक दसूरे को 
काटत ेहैं, वहां पर क्या बनता है? 

(A) Cell       (B) Column 

(C) Formula      (D) None 

 

Q.49. लिबे्र ऑफफस कैल्क में पूरे कॉिम को लसिेक्ट करने के लिये शॉटककट 
कंुजी है? 

(A) Ctrl + Space      (B) Shift + Space 

(C) Ctrl + Shift + Space    (D) Ctrl + Shift + A 

 

Q.50. लिबे्र ऑफफस कैल्क में प्पछिी Row पर जाने के लिए हम कौन सी 
शॉटककट कंुजी का रयोग करत ेहै? 

(A) Tab       (B) Ctrl + Tab  

(C) Shift + Enter     (D) Shift + Tab 

 

Q.51. लिबे्र ऑफफस कैल्क में कॉिम की अधधकतम चौड़ाई फकतनी हो सकती 
है? 

(A) 200       (B) 300 

(C) 100       (D) 50 
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Q.52. िाइबे्ररी ऑफफस स्प्टाइि स्प्रेडशीट में सेि में टेक्स्प्ट का ओररएंटेशन के 
बीच की सीमा से लभन्न होता है? 

(A) 0 & 180      (B) 0 & 359 

(C) 0 & 165      (D) 0 & 155 

 

Q.53. एक सेि फॉमेट को फकसका उपयोग करके दसूरे सेि में कॉपी फकया 
जाता है? 

(A) Clone Formatting     (B) Format Setting 

(C) Format Checking     (D) Cloning 

 

Q.54. कौन सा स्प्रेडशीट व्यू नहीं है? 

(A) Web Layout      (B) Page Brake Preview 

(C) Page Layout      (D) Normal 

 

Q.55. लिबे्र ऑफफस कैल्क के अंतगकत ननम्न में से सही फंक्शन है? 

(A) =Average(5,8,9)     (B) =Average(G2,G5,R4) 

(C) =Average(2+3+5)     (D) a and b 

 

Q.56. ननम्न में से वह कौन सा चाटक है जो चाटक मैन्यू में नहीं होता है? 

(A) Pie Chart      (B) Bar Chart 

(C) Line Chart      (D) Square Chart 

Q.57. लिबे्र ऑफफस कैल्क में Images को जोड़ने के लिए हम फकस Menu का 
रयोग करेंगे? 

(A) Sheet       (B) Insert 

(C) View       (D) Style 
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Q.58. कैल्क के अंतगकत हम एक साथ row को हाइड कर सकत ेहैं? 

(A) True       (B) False 

Q.59. लिबे्र ऑफफस कैल्क में फामूकिे से पहिे + का रयोग फकया जाता है? 

(A) False       (B) True 

Q.60. यटद हम फंक्शन =COUNT(‘A’, ‘B’, ‘C’, 1,2) का रयोग करत ेहैं तो 
ननम्न में से पररणाम क्या होगा? 

(A) B        (B) 1 

(C) 2        (D) B 

 

Q.61. लिबे्र ऑफफस में कमेंट को ऐड करने का प्वकल्प फक मेनू में उपिब्ध है? 

(A) Sheet       (B) Insert 

(C) View       (D) Style 

Q.62. लिबे्र ऑफफस कैल्क में कॉिम की चौड़ाई बढाने के लिए हम कौन सी 
शॉटककट कंुजी का रयोग करत ेहै? 

(A) Alt + Left Arrow     (B) Alt + Right Arrow 

(C) Alt + Ctrl + Right Arrow   (D) None 

Q.63. लिबे्र ऑफफस कैल्क के अंतगकत Maximum value ननकािने के लिये 
सही ऑप्शन A1 to A4? 

(A) =Max(A1;A4)     (B) =Max(A1,A4) 

(C) =Max(A1:A4)     (D) None 

Q.64. स्प्रेडशीट के अंतगकत 2 वकक बुक का एक ही नाम हो सकता है? 

(A) True       (B) False 
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Q.65. लिबे्र ऑफफस कैल्क में F2 कंुजी का रयोग करके हम फकसी भी सेि में 
फामूकिा डाि सकते हैं? 

(A) True       (B) False 

Q.66. Non-numeric लिबे्र ऑफफस कैल्क फकस Alignment में होता है? 

(A) Right       (B) Center 

(C) Justified      (D) Left 

Q.67. लिबे्र ऑफफस कैल्क में कॉिम की बाय डडफॉल्ट चौड़ाई फकतनी होती है? 

(A) .89 inch      (B) .18 inch 

(C) 1.28 inch      (D) 1.05 inch 

Q.68. =Product(35,-8) का मान ननम्न में से क्या होगा? 

(A) 280       (B) -329 

(C) 276       (D) -280 

Q.69. Libreoffice Calc में फकसी एक लसिेक्ट की हुई रो की चौड़ाई को 
बढाया जा सकता हैं? 

(A) True       (B) False 

Q.70. लिबे्र ऑफफस कैल्क में सेि को इन्सटक करने के लिये शॉटककट कंुजी? 

(A) Ctrl + shift+ +      (B) Alt + + 

(C) Ctrl + +       (D) Ctrl + – 

Q.71. लिबे्र ऑफफस कैल्क में एक या उससे ज्यादा वकक शीट पाई जाती है? 

(A) Template       (B) Cell 

(C) Worksheet       (D) Workbook 
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Q.72. लिबे्र ऑफफस राइटर अथवा कैल्क में डोनेट का ऑप्शन फकस मैन्यू में 
आता है? 

(A) File       (B) Insert 

(C) View       (D) Style 

Q.73. लिबे्र ऑफफस कैल्क के अंतगकत =Average(3,4,5) का मान फकतना 
होगा? 

(A) 5        (B) 3 

(C) 9        (D) 4 

Q.74. लिबे्र ऑफफस कैल्क स्प्रेडशीट के अंतगकत सेि को हम कैसे एडडट करेंगे, 

या फफर सेि को एडडट करने के लिए हम कौन सी शॉटककट कंुजी का रयोग 
करेंगे? 

(A) F7        (B) F12 

(C) F2        (D) Alt + F2 

Q.75. लिबे्र ऑफफस कैल्क में फामूकिा फकससे शुरू होता है? 

(A) ?         (B) = 

(C) *         (D) / 

Q.76. लिबे्र ऑफफस कैल्क को पीडीएफ में बदिें? 

(A) Export as PDF      (B) Import as PDF 

(C) Print PDF       (D) Reload PDF 

Q.77. =Quotient(451,7) का मान क्या होगा? 

(A) 70        (B) 64 

(C) 68        (D) 90 
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Q.78. =Round(17231,-5) का मान क्या होगा? 

(A) 1         (B) 17 

(C) 0         (D) 17000 

Q.79.  Libreoffice Calc में टाइम Insert की शॉटककट की ननम्न में से क्या 
है? 

(A) Ctrl + ;        (B) Ctrl + Shift + : 

(C) a and b both      (D) None 

Q.80. लिबे्र ऑफफस कैल्क में ‘फाइि ओपन प्वडंो‘ को िोिने के लिये शॉटककट 
कंुजी क्या होती है? 

(A) Ctrl + Shift + O      (B) Ctrl + O 

(C) Shift + O       (D) None 

Q.81. =MAX(B1:B3)+MIN(B1:B3) का मान क्या होगा यटद B1=5, 
B2=2, B3=7? 

(A) 9         (B) 7 

(C) 2         (D) 5 

Q.82. लिबे्र ऑफफस कैल्क में =Average(1, 2, 4, 9) का मान फकतना होगा? 

(A) 9         (B) 4 

(C) 2         (D) 5 

Q.83. लिबे्र ऑफफस कैल्क में =SUM(A1:B2) का मान फकतना होगा? यटद 
A1=1, A2=2, B1=3 तथा B4=5 है? 

(A) 9         (B) 4 

(C) 2         (D) 6 
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Q.84. शॉटककट key ‘Ctrl + -‘ used for? 

(A) Delete row       (B) Delete sheet 

(C) Delete column      (D) Delete cell 

Q.85. =QUOTIENT(5,2) का फकतना होगा? 

(A) 10        (B) 4 

(C) 2         (D) 6 

Q.86. लिबे्र ऑफफस कैल्क का डडफॉल्ट फॉण्ट नेम क्या है? 

(A) Times New Roman     (B) Liberation Sans 

(C) Liberation Serif      (D) Calibri 

Q.87. लिबे्र ऑफफस कैल्क में िाइन चाटक इंसटक करत ेसमय ननम्नलिखित में से 
कौन िाइन टाइप के ड्रॉप डाउन मेनू में नहीं है? 

(A) Smooth       (B) Straight 

(C) Stepped       (D) Curved 

Q.88. लिबे्र ऑफफस कैल्क आपको स्प्रेडशीट के सेि में प्वशेि वणक सजम्मलित 
करने की सुप्वधा देता है? 

(A) True       (B) False 

Q.89. लिबे्र ऑफफस कैल्क ----------- का एक शजक्तशािी टूि है? 

(A) Spreadsheet package    (B) Communication s/w package 

(C) DBMS package     (D) Document processing package 
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Q.90. एक टेबि में एक सेि से दसूरे सेि में आगे बढने के लिए फकस कंुजी 
का उपयोग करत ेहैं? 

(A) Home       (B) Space 

(C) Enter       (D) Tab 

Q.91. लिबे्र ऑफफस कैल्क में चाटक को इन्सटक फकया जा सकता है? 

(A) True       (B) False 

Q.92. लिबे्र ऑफफस कैल्क एक से ज्यादा Document को Open करने की 
अनुमनत नहीं देता है? 

(A) True       (B) False 

Q.93. स्प्रेडशीट में रैप टेक्स्प्ट है? 

(A) Merge multiple cells    (B) Center text 

(C) multiple text lines in a cell   (D) None of the above 

Q.94. कैल्क में इनमें से कौन सा Cell डडिीट करत ेसमय उपिब्ध नहीं होता 
है? 

(A) Delete Entire Row     (B) Shift Cell Left 

(C) Shift Cell UP     (D) Shift Cell Down 

Q.95. कैल्क में अगिी सीट पर जाने के लिए शॉटककट कंुजी क्या है? 

(A) Page Down       (B) None of these 

(C) Ctrl + Page Down     (D) Shift + Page Down 
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Q.96. लिबे्र ऑफफस कैल्क के अंतगकत अधधकतम जूम 100% रनतशत तक 
होता है? 

(A) True       (B) False 

Q.97. लिबे्र ऑफफस कैल्क में प्रटं रीव्यू जूम करके देि सकत ेहैं? 

(A) True       (B) False 

Q.98. फामूकिा =CONCATENATE("Upciss"," ","Prime") का पररणाम 
क्या होगा? 

(A) Upciss        (B) Prime 

(C) UpcissPrime     (D) Upciss Prime 

Q.99. लिबे्र ऑफफस कैल्क में फकतने रकार के सेि रेफरेंस होत ेहैं? 

(A) 2         (B) 3 

(C) 5        (D) 4 

Q.100. लिबे्र ऑफफस कैल्क के अंतगकत जोड़ ेगए चाटक को 3डी में देिा जा 
सकता है? 

(A) True       (B) False 
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1 ⓑ 

 

21 ⓑ 

 

41 ⓒ 

 

61 ⓒ 

 

81 ⓐ 

2 ⓐ 22 ⓑ 42 ⓐ 62 ⓑ 82 ⓑ 

3 ⓒ 23 ⓓ 43 ⓑ 63 ⓒ 83 ⓓ 

4 ⓑ 24 ⓒ 44 ⓑ 64 ⓑ 84 ⓓ 

5 ⓓ 25 ⓐ 45 ⓓ 65 ⓑ 85 ⓒ 

6 ⓑ 26 ⓐ 46 ⓑ 66 ⓓ 86 ⓑ 

7 ⓒ 27 ⓒ 47 ⓓ 67 ⓐ 87 ⓓ 

8 ⓓ 28 ⓑ 48 ⓐ 68 ⓓ 88 ⓐ 

9 ⓐ 29 ⓑ 49 ⓐ 69 ⓐ 89 ⓐ 

10 ⓐ 30 ⓒ 50 ⓒ 70 ⓒ 90 ⓓ 

11 ⓒ 31 ⓒ 51 ⓒ 71 ⓓ 91 ⓐ 

12 ⓐ 32 ⓐ 52 ⓑ 72 ⓐ 92 ⓑ 

13 ⓒ 33 ⓐ 53 ⓐ 73 ⓓ 93 ⓒ 

14 ⓓ 34 ⓓ 54 ⓒ 74 ⓒ 94 ⓓ 

15 ⓓ 35 ⓐ 55 ⓓ 75 ⓑ 95 ⓒ 

16 ⓐ 36 ⓐ 56 ⓓ 76 ⓐ 96 ⓑ 

17 ⓑ 37 ⓓ 57 ⓑ 77 ⓑ 97 ⓐ 

18 ⓒ 38 ⓒ 58 ⓐ 78 ⓒ 98 ⓓ 

19 ⓓ 39 ⓒ 59 ⓐ 79 ⓑ 99 ⓑ 

20 ⓒ 40 ⓓ 60 ⓒ 80 ⓑ 100 ⓐ 

 

 

 

It takes a lot of hard work to make notes, so if you can pay 

some fee 50, 100, 200 rupees which you think is 

reasonable, if you are able to Thank you... 

नोट्स बनाने में बहुत मेहनत  लगी है , इसललए यलि आप कुछ शुल्क 

50,100, 200 रूपए जो आपको उलित लगता है Pay कर सकते है, अगर 

आप सक्षम है तो, धन्यवाि । 

Answer Keys 
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